Compaq Presario CQ42 Notebook PC
and HP G42 Notebook PC

Maintenance and Service Guide

SUMMARY

This guide is a troubleshooting reference used for maintaining and servicing the computer. It provides
comprehensive information on identifying computer features, components, and spare parts;
troubleshooting computer problems; and performing computer disassembly procedures.
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Safety warning notice

A WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description HP G42 Compaq Compaq Compagq
Presario Presario Presario
CcQ42 cQ42 cQ42
UMA Discrete UMA UMA
Models 150 Models 100
-199 -149
Product Name  Compaq Presario CQ40 3 y \/
Notebook PC
HP G42 Notebook PC v
Processors Intel® Arrandale™
i7-620M, 2.66-GHz, SC turbo, 4-MB N N v
L3 cache
i5-540M, 2.53-GHz, SC turbo, 3-MB N N v
L3 cache
i5-520M, 2.4-GHz, SC turbo, 3-MB N N v
L3 cache
i5-430M 2.26-GHz (turbo to 2.53- v \/ y
GHz) 3-MB L3 cache
i3-350M, 2.26-GHz 3-MB L3 cache N N v
i3-330M, 2.13-GHz 3-MB L3 cache N N v

Intel Pentium™

DC 74400, 2.2-GHz, 800-MHz FSB, N
1-MB L2 cache

DC 74300, 2.1-GHz, 800-MHz FSB, N
1-MB L2 cache

Intel Celeron™

DC T3100, 1.9-GHz, 800-MHz FSB, N
1-MB L2 cache

DC T3000, 1.8-GHz 800-MHz FSB, N
1-MB L2 cache

Chipset Intel® HM55 Express \/ J y

Intel® GL40 v




Category Description HP G42 Compagq Compagq Compaq

Presario Presario Presario
CcQ42 cQ42 cQ42
UMA Discrete UMA UMA
Models 150 Models 100
-199 -149
Southbridge: ICH9m J
Graphics Intel UMA (integrated)/HD \ \/
Graphics with shared video memory
(memory size is dynamic change):
e Upto 251 MB on computers
with 1024 MB of system
memory
e Upto 358 MB on computers
with more than 2048 MB of
system memory
Intel UMA (integrated)/GMA J
4500M - GL4O chipset with
shared video memory (memory size is
dynamic change):
e  Upto 1759 MB for computers
with more than 4096 MB of
system memory (64 bit)
e Upto 1309 MB for computers
with more than 4096 MB of
system memory (32 bit)
e Upto 1309 MB for computers
with more than 3072 MB of
system memory
e Upto 797 MB for computers
with more than 2048 MB system
memory
e Upto 285 MB for computers
with more than 1024 MB of
system memory
ATi Discrete PCI Express x 16 \
Graphics
ATi Mobility Radeon Park-LP S3
package (ATl Mobility Radeon™
HD5430 with 512-MB of dedicated
video memory (64-MBx 16 DDR3, 4
pcs, 800-MHz))
Support for BD or HD-DVD J \ V J

playback with HD decoder and
DX10 support
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Category Description HP G42 Compagq Compaq Compagq

Presario Presario Presario
CcQ42 Q42 Q42
UMA Discrete UMA UMA
Models 150 Models 100
-199 -149
Panel 35.6-cm (14.0-in) HD LED y V \ y
BrightView (1366 x 768 resolution)
16:9 wide aspect ratio y y \ y
Memory 2 SODIMM slots y \/ \ y
Customer-accessible and upgradable 3 V y \/
Supports up to 8 GB of system y \/ y y
memory
DDR3, 1066-MHz, dual-channel N N v
memory (DDR3 1333 MHz can be
downgraded to DDR3 1066 MHz)
DDR3, 800-MHz, dual-channel N
memory (DDR3 1333 MHz can be
downgraded to DDR3 800 MHz)
Supports the following configurations:
e 4096 MB (2048 MB x 2) y V y y
e 3072MB (1024 MB x 1 + y \/ \ y
2048 MB x 1)
e 2048 MB (2048 MB x 1) \/ \/ 3 \/
o 2048 MB (1024 MB x 2) N N N N
e 1024 MB (1024 MB x 1) \/ V \ y
Hard drives Supports 9.5-mm, 6.35-cm (2.5-in) y J \ y
hard drives
Serial ATA y \/ \ y
Supports the following drives:
e 500 GB, 7200 rpm y V 3
e 320 GB, 7200 rpm y \/ \ y
e 250 GB, 7200 rpm y \/ \ y
e 160 GB, 7200 rpm \/ \/ 3
Optical drives Fixed (removal of one screw required) \/ V y \/
SATA 3 V \/ \/
12.7-mm (0.50-in) tray load \/ 3 \/ \/

Supports the following drives:




Category Description HP G42 Compagq Compagq Compaq

Presario Presario Presario
Q42 CQ42 cQ42
UMA Discrete UMA UMA
Models 150 Models 100
-199 -149
®  Blu-ray ROM with LightScribe J 3 V
DVD+R/RW SuperMulti DL Drive
e Blu-ray ROM DVD+R/RW J \ \/
SuperMulti DL Drive
e DVD+R/RW SuperMulti DL Drive v Y N N
with LightScribe
e  DVD+R/RW SuperMulti DL Drive J \ \/ J
Diskette drive Supports external USB drive only \/ 3 V J
Camera VGA camera \/ 3 V J
Fixed (no tilt) \ v N \
640 x 480 by 24 frames per second J y J J
Microphone One microphone, analog \/ 3 3 J
Audio HD audio J 3 \/ J
Supports Microsoft Premium J \ \/ J
requirements
Altec Lansing speakers J y J J
Modem Support for optional high-speed 56k \/ 3 V J
modem
Ethernet Integrated 10/100 network interface v v v v
card (NIC)
Wireless Integrated wireless local area
network (WLAN) options by
way of wireless module:
Intel Centrino Wireless-N 1000 J 3 \/
802.11b/g 1x2
Intel Centrino Wireless-N 1000 J 3 \/
802.11b/g 1x2 plus Broadcom
2070 Bluetooth 2.1+EDR Adapter
Atheros AR9285 802.11b/g/n 1x]1 v v v v
WiFi Adapter
Atheros AR9285 802.11b/g/n 1x]1 v v v v
WiFi Adapter plus Broadcom 2070
Bluetooth 2.1+EDR Adapter
Broadcom 4312G 802.11b/g WiFi v

Adapter

4 Chapter 1 Product description



Category Description HP G42 Compagq Compaq Compagq

Presario Presario Presario
cQa2 cQ42 cQ42
UMA Discrete UMA UMA
Models 150 Models 100
-199 -149
Broadcom 4312G 802.11b/g WiFi v
Adapter plus Broadcom 2070
Bluetooth 2.1+EDR Adapter
Realiek RTL8191SE 802.11b/g/n N N N v
1x1 WiFi Adapter
Realtek RTL8191SE 802.11b/g/n y \/ y y
1x1 WiFi Adapter plus Broadcom
2070 Bluetooth 2.1+EDR Adapter
External media  5-in-1 Digital Media Slot; supports \/ V 3 v
card SD, MMC, MS, Mspro, xD
Single port configured as either HDMI 3 \/ \/
or 5-in-1 Digital Media Slot
Supports mini versions of SD, MMC, y \/ \ \/
and MS Duo with adapter (adapter
not included)
Ports VGA (Dsub 15-pin) supporting 1600 y 3 3 \/
x 1200 resolution at 75 Hz; disabled
when connected to devices through
Expansion port 3
Hot plug/unplug and auto detect for \/ 3 3 v
wide-aspect or standard-aspect video
HDMI v1.3 supporting 1080p with y \/ \ y
HDCP key
Single port configured for either 3 V 3
HDMI or 5-in-1 card reader
USB 2.0 (3) N N N N
RJ-11 (modem) with modem option N \/ v v
RJ-45 (Ethernet, with link and activity \/ N v N
lights)
Audio-in (mono microphone) \/ 3 y \/
Audio-out (stereo headphone) N \/ v N
Smart-pin AC adapter plug y \/ \ y
Keyboard/ 14.0-inch keyboard \/ \/ \/
pointing devices
TouchPad with 2 buttons and 2-way \/ 3 3

scroll (taps enabled as default)




Category Description HP G42 Compagq Compagq Compaq

Presario Presario Presario
cQ42 cQ42 cQ42
UMA Discrete UMA UMA
Models 150 Models 100
-199 -149
Power 6-cell (47-Wh) 2.20-Ah Li-ion battery \ v \/ \
requirements
65-W AC adapter with Smart-Pin DC J J \/
connector
90-W AC adapter with Smart-Pin DC \
connector
Security Security cable slot J \ \/ J
Operating Preinstalled:
system
Windows 7 Professional (32 & 64 \ v N
bit)
Windows 7 Home Premium (32 & 64 v N \
bit)
Windows 7 Home Basic (32 & 64 v \/
bit)
Free DOS \ J J
Serviceability End-user replaceable parts:
AC adapter N \ 3 \/
Battery (system) J \ \/ J
Hard drive J \ \/ J
Memory module \/ 3 V \/
Optical drive \/ y V \/
Mini-card device J \ V J
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2 External component identification

Identifying the hardware

Components included with the computer may vary by region and model. The illustrations in this chapter
identify the standard features on most computer models.

To see a list of hardware installed in the computer, follow these steps:

1. Select Start > My Computer.

2. In the left pane of the System Tasks window, select View system information.
3. Select Hardware tab > Device Manager.

You can also add hardware or modify computer configurations using Device Manager.

Identifying the hardware 7



Top components
TouchPad

RN oy S e ]

Component Description
(1) . TouchPad off indicator To switch the TouchPad zone on and off, quickly doubletap
the TouchPad off indicator.

NOTE: When the TouchPad zone is active, the light is off.

(2) TouchPad zone Moves the pointer and selects or activates items on the screen.
(3) Left TouchPad button Functions like the left button on an external mouse.
(4) Right TouchPad button Functions like the right button on an external mouse.

There is an unmarked scroll zone inside the right edge of the TouchPad. To scroll up and down using
the TouchPad vertical scroll zone, slide your finger up or down inside the right edge of the TouchPad.
For more information about TouchPad features, refer to” Using the TouchPad” section later in this guide.

8  Chapter 2 External component identification



Lights

OLg——

-

Component Description

(1) TouchPad light e On: The TouchPad is disabled.

o Off: The TouchPad is enabled.

(2) Caps lock light On: Caps lock is on.

(3) ﬂ-} Power light e On: The computer is on.
e Blinking: The computer is in the Sleep state.

e Off: The computer is off or in Hibernation.

(4) iy Wireless light e White: An integrated wireless device, such as a
wireless local area network (WLAN) device and/or a
Bluetooth® device, is on.

o Amber: All wireless devices are off.

Top components 9



Button and speakers

O

Component Description

(1) Speakers (2) Produce sound.

(2) Power button ®  When the computer is off, press the button to turn on the
computer.

®  When the computer is on, press the button briefly to
initiate Sleep.

®  When the computer is in the Sleep state, briefly press the
button to exit Sleep.

®  When the computer is in Hibernation, briefly press the
button to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the power
button for at least 5 seconds to turn off the computer.

To learn more about your power settings, select Start >
Control Panel > System and Security > Power
Options.

10 Chapter 2 External component identification



Keys

Component Description

(1) esc key Displays system information when pressed in combination with
the fn key.

(2) fn key Displays system information when pressed in combination with
the esc key.

(3) n Windows logo key Displays the Windows Start menu.

(4) ! Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Navigation keys Navigate using the Up, Down, Left and Right arrow keys.

(6) Action keys Execute frequently used system actions.

Top components
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Display

Component Description

(1) Internal microphone Records sound.

(2) Integrated webcam (select models only) Records audio and video and captures still photographs.
(3) Integrated webcam light (select models only) On: The integrated webcam is in use.

12 Chapter 2 External component identification



Right-side components

-y

Component Description

(1) Optical drive Reads and writes to optical discs.

(2) Optical drive light Blinking: The optical drive is being accessed.

(3) USB port Connects an optional USB device.

(4) RJ-11 (modem) jack (select models only) Connects a modem cable.

(5) AC adapter/power/battery light e  White: The computer is connected to external power and

the battery is fully charged.
e  Blinking white: The computer is in the Sleep state.

e Amber: A battery is charging.

(6) G Power connector

Connects an AC adapter.

(7) ﬂ Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent,
but it may not prevent the computer from being mishandled or
stolen.

Right-side components
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Left-side components

©

yyy!
EHEO0 @

Component

Description

() (]| External monitor port

Connects an external VGA monitor or projector.

(2) Vent

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
infernal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

(3) HDMI port (select models only)

Connects an optional video or audio device, such as a high-
definition television, or any compatible digital or audio
component.

(4) 2 RJ-45 (network) jack

Connects a network cable.

(5) i USB ports (2)

Connects optional USB devices.

(6) ! Audic-in (microphone) jack

Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.

7 {1 Audio-out (headphone) jack

Produces sound when connected to optional powered stereo
speakers, headphones, earbuds, a headset, or television
audio.

(8) Digital Media Slot (select models only)

Supports the following optional digital card formats:
®  Memory Stick (MS)

e Memory Stick Pro (MSP)

e  MultiMediaCard (MMC)

e  Secure Digital (SD) Memory Card

e  xD-Picture Card (XD)

(9) ﬂ Drive light

On: The hard drive is in use.

14 Chapter 2 External component identification



Bottom components

Component

Description

(1) Battery bay

Holds the battery.

(2) {:] B Battery release latch

Releases the battery from the battery bay.

(3) Vents (4)

Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

4 m Memory module compartment

Iy

Contains 2 memory module slots and, on select models, the
wireless LAN (WLAN) device.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module authorized
for use in the computer by the governmental agency that
regulates wireless devices in your country or region. If you
replace the module and then receive a warning message,
remove the module to restore computer functionality, and
then contact technical support through Help and Support.

(5) ﬂ Hard drive bay

Holds the hard drive.

Bottom components
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Wireless antennas

At least 2 antennas send and receive signals from one or more wireless devices. These antennas are
not visible from the outside of the computer.

EY NOTE: For optimal transmission, keep the areas immediately around the antennas free from
obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.

16 Chapter 2 External component identification



Additional hardware components

A

ey

Component Description

(1) Power cord* Connects an AC adapter to an AC outlet.

(2) AC adapter Converts AC power to DC power.

(3) Battery * Powers the computer when the computer is not plugged into

external power.

*Power cords vary in appearance by country or region.

WARNING! Connecting the internal analog modem to a digital line can permanently damage the
modem. Immediately disconnect the modem cable if you accidentally connect it to a digital line.

NOTE: Telephone jacks vary by country or region. To use the modem and the modem cable
(included with select models only) outside the country or region in which you purchased the computer,
you must obtain a country- or region-specific modem cable adapter (included with select models or
purchased separately). The modem must be connected to an analog telephone line using a 6-pin, RJ-11
modem cable (included with select models only). Jacks for digital PBX systems may resemble analog
telephone jacks, but they are not compatible with the modem.

If the modem cable contains noise suppression circuitry, which prevents interference from TV and radio
reception, orient the circuitry end of the cable toward the computer.

Additional hardware components
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3 lllustrated parts catalog

Serial number location

When ordering parts or requesting information, provide the computer serial number and model number
located in the battery bay of the computer.

?

( [/ OO0
Serial: 20000CCOC 1IP0I R0

—Produd: X0000000C IMNMMEMNINNNmm
__Warranty: 1ylyQy

18 Chapter 3 lllustrated parts catalog



Computer major components

Item Description Spare part number

(1) 35.6 cm (14-in), WXGA, BrightView display assembly

NOTE: See Display assembly components on page 24 for more display assembly
infernal component spare part information.

e  For use with integrated microphone and webcam; Presario, matte black 592146-001

Computer major components 19



Item Description Spare part number
®  For use with infegrated microphone and webcam; Presario, biscotti 597617-001
e  For use with infegrated microphone and webcam; HP, biscotti 600163-001
e  For use with integrated microphone and webcam; HP, silver 606155001
e  For use with integrated microphone and webcam; HP, white 606156-001
(2) Keyboards
e  For use in Brazil 600175-201
e  For use in English and French Canada 600175-121
®  For use in Latin America 600175-161
e  For use in South Korea 600175-AD1
e  Foruse in Taiwan 600175-AB1
®  For use in Thailand 600175-281
®  For use in the United States 600175001
(3) Top cover (includes Touchpad, bracket, button board, and cable)
®  Matte black color 600181-001
e  Biscotti color 600182-001
e  Silver color 606161001
e White color 606162001
(4) Power button board (includes cable) 600188-001
(5) Touchpad button board (includes cable) 604603-001
(6) Thermal module — fan and heat assembly (includes thermal material)
e  For use in models that use and UMA graphics subsystem memory and the Intel® 606573001
GL40 chipset
®  For use in models that use Universal Memory Architecture (UMA) graphics subsystem  595832-001
memory"
e  For use in models that use discrete graphics subsystem memory 595833-001
(7) Speaker assembly (includes cable) 600189-001
(8) System boards (includes replacement thermal material)
e  For use in models with discrete graphics subsystem 595181001
®  For use in models with Unified Memory Architecture (UMA) graphics subsystem 595182001
®  For use in models with discrete graphics subsystem and HDMI card reader 595183-001
e  For use in models with UMA graphics subsystem and HDMI card reader 595184-001
®  For use in models with discrete graphics subsystem and Intel® HM55 chipset 608823001
e  For use in models with discrete graphics subsystem, Intel® HM55 chipset, and HDMI ~ 608824-001

card reader
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ltem Description Spare part number
e  For use in models with UMA graphics subsystem memory, Intel® GL40 chipset, and 605140-001
HDMI card reader
9) Plastics Kit (see Plastics Kit on page 26 for more Plastics Kit information) 600190001
(9a) Hard drive compartment cover
(9b) Wireless/memory module mini-card compartment cover
(10)  RTC battery (includes mounting adhesive) 602745-001
(11)  Memory modules
e  2048-MB, PC3-10600, 1333-MHz 598859-001
e  1024-MB, PC3-10600, 1333-MHz 598856-001
(12) Modem module
e  High-speed 56K modem for use in all countries and regions except Australia and 510100001
New Zealand
e  High-speed 56K modem for use in Australia and New Zealand 510100011
(13) WLAN module

Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter

For use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States, and 580101-001
the US Virgin Islands

Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentian, 580101-002
Armenia, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium,
Belize, Benin, Bhutan, Bosnia and Herzegovina, Botswana, Brazil, Brunei, Bulgeria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, Central African
Republic, Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia,
Cyprus, Czech Republic, Zaire, Denmark, Djibouti, Dominica, Dominican Republic,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, laly, Ivory Coast, Jamaica, Japan,
Jordan, Kazakhstan, Kenya, Kiribati, Korea-South, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Martinique, Nether Antilles, French Guiana, Aruba, British
Virgin Islands, Bermuda, Syria, Guadeloupe, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagaascar, Malawi, Malaysia, Maldives, Mali, Malta, Marshall
Islands, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New
Guinea, Paraguay, Peru, Philippines, Poland, Portugal, Republic of Moldova,
Romania, rwanda, Samoa, San Marino, Sao tfome and Principe, Saudi Arabia,
Senegal, Serbia and Montenegro, Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, Solomon Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and Gren, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Thailand, Timor (East), Togo, Tonga, Trinidad and
Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, United Arab

Emirates ,United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zambia, and Zimbabwe

Intel Centrino Wireless-N 1000 802.11b/g/n 1x2 593530-001

Computer major components
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Item Description

Spare part number

Broadcom 4312G 802.11b/g WiFi Adapter (halogen free)

For use in Canada, Cayman Islands, Guam, Puerto Rico, the United States, and the
U.S. Virgin Islands

582562-001

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, The Bahamas, Bahrain,

Bangladesh, Barbados, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and

Herzegovina, Botswana, Brazil, The British Virgin Islands, Brunei, Bulgaria, Burkina
Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
China, Colombia, Comoros, Congo, Costa, Rica, Croatia, Cyprus, The Czech
Republic, Denmark, Djibouti, Dominica, The Dominican Republic, East Timor ,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French, Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, ltaly, The
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedoniq,
Madagascar, Malawi, The Maldives, Mali, Malta, The Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, The Nether Antilles, The
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan,
Palau, Panama, Papua New Guinea, Paraguay, Peru, The Philippines, Poland,
Portugal, Puerto Rico, The Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome and Principe Saudi Arabia, Senegal, Serbia and
Montenegro, The Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, The
Solomon Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia,
St. Vincent and Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, The United Arab Emirates, The United Kingdom,
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia and
Zimbabwe

582562-002

Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter

593533-001

(14)  Processor (includes replacement thermal material)

Intel Arrandale Core 620M 2.26-GHz

587259-001

Intel Arrandale 540M 2.53-GHz

594188-001

Intel Arrandale 520M 2.4-GHz

594187-001

Intel Arrandale i5-430M 2.26-GHz

597624-001

Intel Arrandale i3-350M 2.26-GHz

597623-001

Intel Arrandale i3-330M 2.13-GHz

597622-001

Intel Core 2 Duo Mobile processor T3000, 1.8-GHz

572926-001

Intel Core 2 Duo Mobile processor T4400 - 2.2-GHz

584296-001

Intel Core 2 Duo Mobile, T4300, 2.1-GHz

572929-001

Intel Core 2 Duo Mobile processor T3100 - 1.9-GHz

572925-001

Intel Core 2 Duo Mobile processor T3300 2.0-GHz

592399-001

(15) USB board (includes cable)

600631-001
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ltem Description Spare part number
(16) Modem (RJ-11) cable (includes RJ-11 connector with modem cable) 610791-001
(17)  Power connector cable (includes power connector and cable) 600630001
(18) Base enclosure (with modem cable and ODD cable)
®  For use with HDMI card reader and without modem module, biscotti 600177-001
e  For use without HDMI card reader and with modem module, biscotti 600178-001
®  For use with HDMI card reader and without modem module, silver 608912-001
e  For use with HDMI card reader and without modem, white 608913-001
®  For use with HDMI card reader without modem, matte black 600179-001
e  For use without HDMI card reader and with modem module, matte black 600180-001
(19) Bluetooth module 537921-001
Bluetooth module cable (illustrated with Bluetooth module) 602822-001
(20) Battery
o 6ecell 47-WH (2.2-Ah) Ll-ion 593553-001
o 6cell 55:WH (2.55-Ah) Lion 593554.001
(21)  Hard drive (include hard drive bracket)
e 500-GB 7200 RPM 600170-001
e 320-GB 7200 RPM 600169-001
e  250-GB 7200 RPM 575598-001
e 160-GB 7200 RPM 600167-001
(22) Hard drive cable/adapter (included with the cable kit; see Mass storage devices 610791-001
on page 27)
(23) Optical drive cable (included in the cable kit) 610791-001
(24) Optical drives (12.7 mm, SATA, fixed)
®  Blu-ray Disc ROM LightScribe with SuperMulti DVD+R/RW Double-Layer, matte black  600173-001
e  Bluray Disc ROM LightScribe with SuperMulti DVDxR/RW Double-Layer, biscotti 600174-001
e  Blu-ray Disc ROM LightScribe with SuperMulti DVD+R/RW Double-Layer, silver 608121-001
e  Blu-ray Disc ROM LightScribe with SuperMulti DVD+R/RW Double-Layer, white 608122-001
e DVD+RW SuperMulti DL Drive with LightScribe, matte black 600171-001
e DVDxRW SuperMulti DL Drive with LightScribe, biscotti 600172-001
e DVD=RW SuperMulti DL Drive with LightScribe, silver 608119-001
e DVD+RW SuperMulti DL Drive with LightScribe, white 608120001

Computer major components
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Display assembly components

F

ltem Description Spare part number
(1) Display bezel
e HP, for use with microphone and webcam 592147-001
e Presario, for use with microphone and webcam 592148001
(2) 35.6 cm (14-in) high definition, Brightview, display panel (includes display panel cable) 592144-001
(3) Display hinge cover 592150001
Display bracket (with hinges) 600627-001
Display cable kit 592151-001
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Item Description Spare part number
Display cable (shown with display panel)
(4) Webcam cable
(5) Antennas and cables

(6) Display back cover
®  Presario, matte black 592149-001
®  Presario, biscofti 600164-001
e HP, biscotti 600165-001
e HP, silver 606157-001
e HP, white 606158-001

(7) Webcam module 600166001
Display screw kit (not illustrated; includes screws and screw covers) 592152001
Display rubber display kit (not illustrated) 595198001

Display assembly components
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Plastics Kit

o—

Item Description Spare part number
Plastics kit 600190001

(1) Hard drive bay cover (includes captive screws)

(2) Wireless/memory module mini-card compartment cover (includes captive screw)
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Mass storage devices

Item Description Spare part number

(1) Hard drive (include hard drive bracket)

e 500-GB 7200 RPM 600170-001
e  320-GB 7200 RPM 600169-001
e  250-GB 7200 RPM 575598-001
e 160-GB 7200 RPM 600167-001
Hard drive hardware kit (contains screws, hard drive bracket, not illustrated) 600191-001
Hard drive cable/adapter (included in the cable kit) 610791-001

(2) Optical drives (12.7 mm, SATA, fixed)

e Blu-ray Disc ROM LightScribe with SuperMulti DVD+R/RW Double-layer, matte black ~ 600173-001

e  Blu-ray Disc ROM LightScribe with SuperMulti DVD+R/RW Double-layer, biscotti 600174-001
e  Blu-ray Disc ROM LightScribe with SuperMulti DVD+R/RW Double-Layer, silver 608121-001
e Bluray Disc ROM LightScribe with SuperMulti DVD+R/RW Double-Layer, white 608122001
e DVD=RW SuperMulti DL Drive with LightScribe, matte black 600171-001
e DVDxRW SuperMulti DL Drive with LightScribe, biscotti 600172001
e DVD=RW SuperMulti DL Drive with LightScribe, silver 608119001
e DVDxRW SuperMulti DL Drive with LightScribe, white 608120001
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Miscellaneous parts

Description Spare part number

AC adapters

e 90-W Smart AC adapter with power factor correction (PFC) 613152-001
e 90-W AC adapter with power factor correction (PFC) 613160-001
e 65W AC Smart, slim, AC adapter 613153-001
e 65W Smart power adapter with power factor correction (PFC) for use in India 613161-001

Power cord, AC, 3 wire, black, 1.83-m

e  For use in Argentina 490371-D01
e For use in Australia 490371-011
e  For use in Brazil 490371-202
e  Forusein India 490371-D61
e  Forusein lialy 490371061
e For use in North America 490371-001
®  Foruse in South Korea 490371-AD1
e For use in Taiwan 490371-AB1
®  For use in Thailand 490371-201
®  For use in the People's Republic of China 490371-AA1
®  For use in the United Kingdom and Singapore 490371-031
Rubber kit 600184-001
Screw kit 595202001

e Phillips M2.0x3.0 screw
e  Phillips M2.5x3.0 screw
e Phillips M2.5x4.0 screw
e  Phillips M2.5x5.0 screw

e  Phillips M2.5x6.5 screw
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Sequential part number listing

Spare part Description
number

490371-001 Power cord, AC, 3-pin, black, 1.83-m, for use in North America

490371011 Power cord, AC, 3-pin, black, 1.83-m, for use in Australia

490371-031 Power cord, AC, 3-pin, black, 1.83-m, for use in the United Kingdom and Singapore

490371-061 Power cord, AC, 3-pin, black, 1.83-m, for use in ltaly

490371-201 Power cord, AC, 3-pin, black, 1.83-m, for use in Thailand

490371-202 Power cord, AC, 3-pin, black, 1.83-m, for use in Brazil

49037 1-AA1 Power cord, AC, 3-pin, black,1.83-m, for use in the People's Republic of China

490371-AB1 Power cord, AC, 3-pin, black,1.83-m, for use in Taiwan

490371-AD1 Power cord, AC, 3-pin, black,1.83-m, for use in South Korea

490371-D01 Power cord, AC, 3-pin, black,1.83-m, for use in Argentina

490371-D61 Power cord, AC, 3-pin, black,1.83-m, for use in India

510100-001  Modem module, high-speed 56K modem for use in all countries and regions except Australia and New
Zealand

510100-011  Modem module, high-speed 56K modem for use in Australia and New Zealand

537921-001 Bluetooth module without cable

572925-001 Processor, Intel Core 2 Duo Mobile processor T3100 - 1.9-GHz

572926-001 Processor, Intel Core 2 Duo Mobile processor T3000, 1.8-GHz

572929-001 Processor, Intel Core 2 Duo Mobile, 74300, 2.1-GHz

575598-001 Hard disk drive, 250-GB 7200 RPM

580101-001 Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter for use in Canada, the Cayman Islands, Guam, Puerto
Rico, the United States, and the US Virgin Islands
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Spare part
number

Description

580101-002

Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Australia, Austria, Azerbaijan, Bahamas, Bahrain,
Barbados, Belgium, Belize, Benin, Bhutan, Bosnia and Herzegovina, Botswana, Brazil, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, Central African Republic, Chad, Chile, China,
Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, Czech Republic, Zaire, Denmark, Djibouti,
Dominica, Dominican Republic, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia,
Fiji, Finland, France, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India,
Indonesia, Ireland, ltaly, Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Korea-South,
Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Martinique, Nether Antilles, French Guiana,
Aruba, British Virgin Islands, Bermuda, Syria, Guadeloupe, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, Maldives, Mali, Malta, Marshall Islands, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama, Papua
New Guinea, Paraguay, Peru, Philippines, Poland, Portugal, Republic of Moldova, Romania, Rwanda,
Samoa, San Marino, Sao tome and Principe, Saudi Arabia, Senegal, Serbia and Montenegro, Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, Solomon Islands, Somalia, South Africa, Spain, Sri Lanka, St.
Kitts and Nevis, St. Lucia, St. Vincent and Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Thailand, Timor (East), Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, United Arab Emirates, United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietham, Yemen, Zambia, and Zimbabwe

582562-001

Broadcom 4312G 802.11b/g WiFi adapter for use in Canada, Cayman Islands, Guam, Puerto Rico, the
United States, and the U.S. Virgin Islands

582562-002

Broadcom 4312G 802.11b/g WiFi adapter for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, The Bahamas, Bahrain,
Bangladesh, Barbados, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, The British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape
Verde, the Central African Republic, Chad, Chile, China, Colombia, Comoros, Congo, Costa, Rica, Croatia,
Cyprus, The Czech Republic, Denmark, Djibouti, Dominica, The Dominican Republic, East Timor , Ecuador,
Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French, Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, ltaly, The
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, The Maldives, Mali, Malta,
The Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, The Nether Antilles, The Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guineq,
Paraguay, Peru, The Philippines, Poland, Portugal, Puerto Rico, The Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome and Principe Saudi Arabia, Senegal, Serbia and Montenegro, The
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, The Solomon Islands, Somalia, South Africa, Spain,
Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent and Gren, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, The United Arab Emirates, The United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia and Zimbabwe

584296-001

Processor, Intel Core 2 Duo Mobile processor T4400 - 2.2-GHz

587259-001

Processor, Intel Arrandale Core 620M 2.26-GHz

592144-001

Display panel, 35.6 em (14-in) high definition, Brightview

592146-001

35.6 em (14-in) WXGA Brightview display assembly for use with integrated microphone and webcam;
Presario, matte black

592147-001

Display bezel, HP, for use with microphone and webcam
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Spare part

Description

number

592148-001 Display bezel, Presario, for use with microphone and webcam

592149-001 Display back cover, Presario, matte black

592150001 Display hinge cover

592151-001 Display cable kit

592152-001 Display screw kit (not illustrated)

592399-001 Processor, Intel Core 2 Duo Mobile processor T3300 2.0-GHz

593530-001 Intel Centrino Wireless-N 1000 802.11b/g/n 1x2

593533001 Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter

593553-001 Battery, é-cell 47-WH (2.2-Ah) Ll-ion

593554-001 Battery, 6-cell 55-WH (2.55Ah) Ll-ion

594187-001 Processor, Intel Arrandale 520M 2.4-GHz

594188-001 Processor, Intel Arrandale 540M 2.53-GHz

595181-001 System board (includes replacement thermal material) for use in models with discrete graphics subsystem

595182-001 System board (includes replacement thermal material) for use in models with Unified Memory Architecture
(UMA) graphics subsystem

595183-001 System board (includes replacement thermal material) for use in models with discrete graphics subsystem and
HDMI card reader

595184-001 System board (includes replacement thermal material) for use in models with UMA graphics subsystem and
HDMI card reader

595198-001  Display rubber kit

595202-001 Screw kit

595832-001 Thermal module (includes fan and heat sink) for use in models that use Universal Memory Architecture (UMA)
graphics subsystem memory

595833-001 Thermal module (includes fan and heat sink) for use in models that use discrete graphics subsystem memory

597617-001 35.6 ecm (14-in) WXGA Brightview display assembly for use with integrated microphone and webcam;
Presario, biscotti

597622-001 Processor, Intel Arrandale i3-330M 2.13-GHz

597623-001 Processor, Intel Arrandale i3-350M 2.26-GHz

597624-001 Processor, Intel Arrandale i5-430M 2.26-GHz

598856-001 Memory module, 2048-MB, PC3 10600, 1333-MHz

598859-001 Memory module, 1024-MB, PC3 10600, 1333-MHz

600163-001  35.6 em (14-in) WXGA Brightview display assembly for use with integrated microphone and webcam; HP,
biscotti

600164-001 Display back cover, Presario, biscotti
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number

Description

600165-001

Display back cover, HP, biscotti

600166-001

Webcam module

600167-001

Hard disk drive, 160-GB 7200 RPM

600169-001

Hard disk drive, 320-GB 7200 RPM

600170-001

Hard disk drive, 500-GB 7200 RPM

600171-001

Optical drive, DVD+RW SuperMulti DL Drive with LightScribe, matte black

600172-001

Optical drive, DVD+RW SuperMulti DL Drive with LightScribe, biscotti

600173-001

Optical drive, Blu-ray Disc ROM LightScribe with SuperMulti DVD£R/RW Double-Layer, matte black

600174-001

Optical drive, Blu-ray Disc ROM LightScribe with SuperMulti DVD+R/RW Double-Layer, biscotti

600175-001

Keyboard for use in the United States

600175-121

Keyboard for use in English and French Canada

600175-161

Keyboard for use in Latin America

600175-201

Keyboard for use in Brazil

600175-281

Keyboard for use in Thailand

600175-AB1

Keyboard for use in Taiwan

600175-AD1

Keyboard for use in South Korea

600177-001

Base enclosure (with modem cable and ODD cable) for use with HDMI card reader and without modem
module, biscotti

600178-001

Base enclosure (with modem cable and ODD cable) for use without HDMI card reader and with modem
module, biscotti

600179-001

Base enclosure (with modem cable and ODD cable) for use with HDMI card reader without modem, matte

black

600180-001

Base enclosure (with modem cable and ODD cable) for use without HDMI card reader and with modem
module, matte black

600181-001

Top cover (includes Touchpad and bracket, button board, and cable), matte black color

600182001

Top cover (includes Touchpad and bracket, button board, and cable) , bicotti color

600184-001

Rubber kit

600188-001

Power button board (includes cable)

600189-001

Speaker assembly (includes cable)

600190001

Plastics kit (with hard drive compartment cover and memory/wireless compartment cover)

600191-001

Hard drive hardware kit (screws and hard drive bracket)

600627-001

Display bracket (with hinges)

600630-001

Power connector with cable
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Spare part

Description

number

600631-001 USB board with cable

602745-001 RTC battery

602822-001 Bluetooth cable

604603-001 Touchpad board (includes cable)

605140-001 System board (includes replacement thermal material) for use in models with UMA graphics subsystem
memory, Intel® GL40 chipset, and HDMI card reader

606155-001 35.6 cm (14-in) WXGA Brightview display assembly for use with integrated microphone and webcam; HP,
silver

606156-001 35.6 ecm (14-in) WXGA Brightview display assembly for use with integrated microphone and webcam; HP,
white

606157-001 Display back cover, HP, silver

606158001 Display back cover, HP, white

606161-001 Top cover (includes Touchpad and bracket, button board, and cable) , silver color

606162-001 Top cover (includes Touchpad and bracket, button board, and cable), white color

606573-001 Thermal module (includes fan and heat sink) for use in models that use and UMA graphics subsystem memory
and the Intel® GL40 chipset

608119-001 Optical drive, DVD+RW SuperMulti DL Drive with LightScribe, silver

608120-001 Optical drive, DVDxRW SuperMulti DL Drive with LightScribe, white

608121-001 Ocptical drive, Blu-ray Disc ROM LightScribe with SuperMulti DVD+R/RW Double-Layer, silver

608122-001 Ocptical drive, Blu-ray Disc ROM LightScribe with SuperMulti DVD£R/RW Double-Layer, white

608823-001  System board (includes replacement thermal material) for use in models with discrete graphics subsystem and
Intel® HM55 chipset

608824-001  System board (includes replacement thermal material) for use in models with discrete graphics subsystem,
Intel® HM55 chipset, and HDMI card reader

608912-001 Base enclosure (with modem cable and ODD cable) for use with HDMI card reader and without modem
module, silver

608913-001 Base enclosure (with modem cable and ODD cable) for use with HDMI card reader and without modem,
white

610791-001 Optical drive cable (included in the cable kit)

610791-001  Modem (RJ-11 cable with modem connector included in the cable kit)

610791-001  Hard drive cable/adaptor (included in the cable kit)

613152-001  65-W Smart AC adapter

613153-001 90-W AC adapter with power factor correction (PFC)

613160-001 90-W AC adapter RC/V EM, with power factor correction (PFC)

613161-001 65-W AC adapter with power factor correction (PFC) for use in India
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
®  Flatbladed screwdriver
®  Magnetic screwdriver

e  Phillips PO and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

B NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.
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Cables and connectors

A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Drive handling

A CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive fo electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

A CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

A CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800 V 400V
Removing DIPS from plastic tube 2,000V 700V 400 vV
Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at staticfree workstations.

Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of staticsafe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at staticfree workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

®  When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm £10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

®  When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
e Antistatic tape

®  Antistatic smocks, aprons, and sleeve protectors

e  Conductive bins and other assembly or soldering aids

®  Nonconductive foam

e  Conductive tabletop workstations with ground cords of one megohm resistance
e  Static-dissipative tables or floor mats with hard ties to the ground

e  Field service kits

e  Static awareness labels

®  Material-handling packages

e Nonconductive plastic bags, tubes, or boxes

®  Mefal tote boxes

e  Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000V
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Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 75 screws, in 12 different sizes, that must be removed, replaced, or loosened

when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Serial number

The serial number label, located in the battery bay of the computer, provides important information that
you may need when contacting technical support.

e
@ || Serial: XOOCOOOCK | I 1001101 10X 100 001 HAR AN
® —— Product: XOOCO0OOK |INININIE NI I NI NI N N

€ —— Warranty: 1y1y0y
© | Model: X3000XX

(1) Product name (4) Warranty period

(2) Serial number (5) Model description (select models)

(3) Product number
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Computer feet

Description Spare part number

Rubber Feet Kit 600184-001

The computer feet are adhesive-backed rubber pads. The feet attach to the base enclosure in the
locations illustrated below.
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Battery

Description Spare part number
6-cell 55-WH (2.55Ah) Li-ion 593554-001
6-cell 47-WH (2.2-Ah) Ll-ion 593553-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface.

2. Slide the battery release latch (1) to release the battery.

3. Pivot the battery (2) upward and lift it out of the computer (3).

To insert the battery, insert the rear edge of the battery into the battery bay and pivot the front edge
downward until the battery is seated. The battery release latch automatically locks the battery into
place.
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Hard drive

B NOTE: All hard drive spare part kits include a hard drive bracket.

Description Spare part number
500-GB 7200 RPM 600170-001
320-GB 7200 RPM 600169-001
250-GB 7200 RPM 575598-001
160-GB 7200 RPM 600167-001
Hard drive hardware kit (includes screws and hard drive bracket) 600191-001
Hard drive cable/adaptor (included in the cable kit) 610791-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the

computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet

and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).
Remove the hard drive:

1. Position the computer with the front toward you.

2. Remove the two Phillips PM2.5x5.0 screws (1) that secure the hard drive cover to the computer.
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3. Lift the left side of the hard drive cover (2), swing it forward, and remove the cover (3). The hard
drive cover is included in the plastics kit, spare part number 600190-001.

4. Remove the three Phillips PM2.5%4.0 screws (1) that secure the hard drive to the computer.

5. Use the hard drive bracket to lift the hard drive out (2) of the hard drive compartment.
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6. Disconnect the hard drive cable from the system board.

7. Remove the hard drive.

8. |Ifitis necessary to replace the hard drive bracket, remove the four Phillips PM3.0x3.0 screws (1)
that secure the hard drive bracket to the hard drive

9. lift the bracket (2) straight up.

Reverse this procedure to install the hard drive.
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Optical drive

Description Spare part
number
DVDxRW SuperMulti DL Drive with LightScribe, matte black 600171-001
DVD=RW SuperMulti DL Drive with LightScribe, biscotti 600172001
DVD+RW SuperMulti DL Drive with LightScribe, silver 608119001
DVD+RW SuperMulti DL Drive with LightScribe, white 608120-001
Blu-ray Disc ROM LightScribe with SuperMulti DVD+R/RW Double-Layer, matte black 600173-001
Blu-ray Disc ROM LightScribe with SuperMulti DVD+R/RW Double-Layer, biscotti 600174-001
Blu-ray Disc ROM LightScribe with SuperMulti DVD+R/RW Double-Layer, silver 608121-001
Blu-ray Disc ROM LightScribe with SuperMulti DVD+R/RW Double-Layer, white 608122-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the

computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet

and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).
Remove the optical drive:

1. Position the computer upside down with the front toward you.

2. Remove the Phillips PM2.5x5.0 screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the access point through the hard drive
compartment (2), and then push the drive bracket to the left to release the optical drive.
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4. Remove the optical drive (3).

5. |Ifitis necessary to replace the optical drive bracket, position the optical drive with the optical
drive bracket toward you.

6. Remove the two Phillips PM2.0x3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7. Remove the optical drive bracket (2).

—%‘

J:""i?o

Reverse the above procedure to reassemble and install the optical drive.
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WLAN module

Description Spare part
number

Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter for use in Canada, the Cayman Islands, Guam, 580101-001
Puerto Rico, the United States, and the US Virgin Islands

Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter for use in Afghanistan, Albania, Algeria, Andorra, 580101-002
Angola, Antigua and Barbuda, Argentian, Armenia, Australia, Austria, Azerbaijan, Bahamas, Bahrain,
Barbados, Belgium, Belize, Benin, Bhutan, Bosnia and Herzegovina, Botswana, Brazil, Brunei, Bulgeria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, Central African Republic, Chad, Chile,
China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, Czech Republic, Zaire, Denmark,
Djibouti, Dominica, Dominican Republic, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Indonesia, Ireland, ltaly, Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Korea-
South, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Martinique, Nether Antilles, French
Guiana, Aruba, British Virgin Islands, Bermuda, Syria, Guadeloupe, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagaascar, Malawi, Malaysia, Maldives, Mali, Malta, Marshall Islands,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Palau, Panama, Papua New Guinea, Paraguay, Peru, Philippines, Poland, Portugal, Republic of
Moldova, Romania, rwanda, Samoa, San Marino, Sao tome and Principe, Saudi Arabia, Senegal,
Serbia and Montenegro, Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, Solomon Islands,
Somalia, South Africa, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and Gren, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Timor (East), Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, United Arab Emirates ,United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zambia, and Zimbabwe

Intel Centrino Wireless-N 1000 802.11b/g/n 1x2 593530-001

Broadcom 4312G 802.11b/g WiFi Adapter for use in Canada, Cayman Islands, Guam, Puerto Rico, 582562-001
the United States, and the U.S. Virgin Islands

Broadcom 4312G 802.11b/g WiFi Adapter for use in Afghanistan, Albania, Algeria, Andorra, Angola, 582562-002
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, The Bahamas,
Bahrain, Bangladesh, Barbados, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, The British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, China, Colombia, Comoros, Congo,
Costa, Rica, Croatia, Cyprus, The Czech Republic, Denmark, Djibouti, Dominica, The Dominican
Republic, East Timor , Ecuador, Egypt, El Salvador, Equitorial Guineq, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French, Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, ltaly, The Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, The Maldives, Mali, Malta, The Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia,
Nauru, Nepal, The Nether Antilles, The Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guineaq, Paraguay, Peru, The Philippines, Poland,
Portugal, Puerto Rico, The Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao
Tome and Principe Saudi Arabia, Senegal, Serbia and Montenegro, The Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, The Solomon Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts &
Nevis, St. Lucia, St. Vincent and Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, The
United Arab Emirates, The United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia and Zimbabwe

Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter 593533-001
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Before removing the WLAN module, follow these steps:

1.

4.
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the hard drive cover (see Hard drive on page 42).

Remove the WLAN module:

1.
2.

Turn the computer upside down with the front toward you.

Loosen the 2 Phillips PM2.5x5.0 captive screws (1) that secure the mini-card compartment cover.

Lift the cover off the computer (2). The mini-card compartment cover is included in the plastics kit,
spare part number 600190-001.

Disconnect the two WLAN antenna cables (1) from the WLAN module.

Remove the Phillips PM2.0x3.0 screw (2) that secures the WLAN module to the computer. (The
edge of the module opposite the slot rises away from the computer.)
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6. Remove the WLAN module (3) by pulling it away from the slot at an angle.

A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore computer functionality, and then contact technical support through
Help and Support.

EY NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion into the
WILAN module slot.

Reverse this procedure to install a WLAN module.
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Memory module

Description Spare part number
2048-MB, PC3 10600, 1333-MHz 598856-001
1024-MB, PC3 10600, 1333-MHz 598859-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the memory module:
1. Turn the computer upside down with the front toward you.

2. Loosen the two Phillips PM2.5x5.0 captive screws that secure the mini-card compartment cover to
the computer.
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3. Lift cover off the computer. The mini-card compartment cover is included in the plastics kit, spare
part number 600190-001.

EY NOTE: Small tabs hold the cover in place. Firmly pull up on the cover fo release the tabs.

4. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

5. Remove the module (2) by pulling it away from the slot at an angle.

EY NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Keyboard

Description Spare part number
Keyboard for use in Brazil 600175-201
Keyboard for use in English and French Canada 600175-121
Keyboard for use in for use in Latin America 600175-161
Keyboard for use in South Korea 600175-AD1
Keyboard for use in Taiwan 600175-AB1
Keyboard for use in Thailand 600175-281
Keyboard for use in the United States 600175-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the hard drive (see Hard drive on page 42)

6. Remove the mini-card compartment cover (see WLAN module on page 47).

Remove the keyboard:
1. Turn the computer upside down with the front toward you.

2. Remove the six Phillips PM2.5x6.5 screws that secure the keyboard to the computer.
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3. Turn the computer display-side up with the front toward you.
4. Open the computer as far as possible.

5. Release the top edge of the keyboard by lifting it up to disengage the keyboard from the tabs on
the top cover (1).

6. Slide the top edge of the keyboard back (2) until it rests against the display.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached and
disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Top cover

Description Spare part number
Top cover (includes Touchpad and bracket, button board, and cable), matte black 600181-001
Top cover, bicotti 600182-001
Top cover, silver 606161001
Top cover, white 606162-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 41).

b. Optical drive (see Optical drive on page 45).

c. Keyboard (see Keyboard on page 52).

Remove the switch cover:
1. Turn the computer upside down with the front foward you.

2. Remove the four screw covers (1) at the front edge of the computer.
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3.

Remove the five Phillips PM2.5x6.5 screws (2), the two Phillips PM2.5x4.0 screws (3), and the
four Phillips PM2.5x3.0 screws (4) that secure the top cover to the base enclosure.

Turn the computer display-side up with the front toward you.
Open the computer as far as possible.

Release the ZIF connector to which the touchpad (1) is connected and disconnect the cable from
the system board.

Release the ZIF connector to which the touchpad button board cable (2) is connected and
disconnect the cable from the system board.

Disconnect the speaker cable (3) from the system board.
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9. Release the ZIF connector to which the power button board cable (4) is connector and disconnect
the cable from the system board.

10. Remove the Phillips PM2.5%6.5 screw (1) from the top cover, disengage the rear edge of the top
cover (2) from the base enclosure, and then remove the cover from the computer (3).

Reverse this procedure to install the switch cover.
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Speaker assembly

Description Spare part number

Speaker assembly 600189-001

Before removing the speaker assembly, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the following components:

a. Optical drive (see Optical drive on page 45)

b. Keyboard (see Keyboard on page 52)

c. Top cover (see Top cover on page 54)

Remove the speaker assembly:

1.
2.

Turn the top cover upside down.

Remove the two Phillips PM2.5x4.0 screws (1) that secure the speaker assembly to the computer.

Lift the speaker assembly (2) straight up to remove it from the top cover.

Reverse this procedure to install the speaker assembly.
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Power button board

Description Spare part number

Power button board (with cable) 600188-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 52)

d. Top cover (see Top cover on page 54)

Remove the power button board:
1. Turn the top cover upside down with the rear edge toward you.
2. Remove the Phillips PM2.5x3.0 screw (1) that secures the power button board to the top cover.

3. Remove the power button board (2).

< ¥

e Y
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TouchPad button board

Description Spare part number

TouchPad button board 604603-001

Before removing the TouchPad button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 52)

d. Top cover (see Top cover on page 54)

Remove the TouchPad button board:
1. Turn the top cover upside down with the front toward you.
2. Remove the two Phillips PM2.5x3.0 screws (1) that secure the TouchPad board to the top cover.

3. Remove the TouchPad button board (2) from the TouchPad bracket.
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Reverse the above procedure to reassemble and install the TouchPad button board.
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Modem module

Description Spare part number
High-speed 56K modem for use in all countries and regions except Australia and New Zealand 510100-001
High-speed 56K modem for use in Australia and New Zealand 510100011
Modem module cable with RJ-11 connector (included in the cable kit) 610791001

Before removing the modem module, follow these steps:

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 52)

d. Top cover (see Top cover on page 54)

Remove the modem module:

Turn the computer upright with the front toward you.

Remove the two Phillips PM2.0x3.0 screws (1) that secure the modem module to the system

board.

Disconnect the modem module cable (2) from the modem module.

Component replacement procedures

61



4. Lift up on the front of the modem module (3) to disconnect it from the system board.

5. Remove the modem module.

Reverse the above procedure to install the modem module, and be sure that the connector on the
bottom of the modem module connects firmly into the system board.
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Bluetooth module

Description Spare part number
Bluetooth module 537921-001
Bluetooth module cable 602822-001

Before removing the Bluetooth module, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 52)

d. Top cover (see Top cover on page 54)

Remove the Bluetooth module:

ol A

Position the computer upright with the front toward you.
Disconnect the Bluetooth module cable (1) from the system board.
Remove the Bluetooth module and cable from the clips in the base enclosure (2).

Remove the Bluetooth module (3) from the base enclosure.
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Reverse the above procedure to install the Bluetooth module.
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USB board

Description Spare part number

USB board (includes cable) 600631-001

Before removing the USB board, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 52)

d. Top cover (see Top cover on page 54)

Remove the USB board:

ol S

Position the computer upright with the right side toward you.
Disconnect the USB board cable (1) from the system board.
Remove the Phillips PM2.5x3.0 screw (2) that secures the USB board to the base enclosure.

Lift the USB board (3) straight up to remove it from the computer.
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Reverse this procedure to install the USB board.
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Power connector cable

Description Spare part number

Power connector cable (includes cable and connector) 600188-001

Before removing the power connector cable, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the following components:

a.
b.
c.

d.

Hard drive (see Hard drive on page 42)

Optical drive (see Optical drive on page 45)

Keyboard (see Keyboard on page 52)

Top cover (see Top cover on page 54))

Remove the power connector cable:

1.

Turn the computer upright with the right side toward you.

2. Disconnect the power connector cable (1) from the system board.

3.

4.

Lift the power connector (2) from the clips built into the base enclosure.

Remove the cable from the base enclosure.
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Reverse this procedure to install the power connector cable.
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Display assembly

Description Spare part number

35.6 ¢cm (14-in) WXGA Brightview display assembly for use with integrated microphone and 592146-001
webcam; Presario, matte black

35.6 ecm (14-in) WXGA Brightview display assembly for use with integrated microphone and 597617001
webcam; Presario, biscotti

35.6 ¢cm (14-in) WXGA Brightview display assembly for use with integrated microphone and 600163-001
webcam; HP, biscotti

35.6 ¢cm (14-in) WXGA Brightview display assembly for use with integrated microphone and 606155-001
webcam; HP, silver

35.6 ¢cm (14-in) WXGA Brightview display assembly for use with integrated microphone and 606156-001
webcam; HP, white

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Disconnect the wireless antenna cables from the WLAN module (see WLAN module on page 47).

6. Remove the following components:

a. Keyboard (see Keyboard on page 52)

b. Optical drive (see Optical drive on page 45)

c. Top cover (see Top cover on page 54)

Remove the display assembly:

1. Turn the computer display-side up, with the front toward you.

. Open the display as far as possible.

Remove the wireless antenna cables (1) from the hole and clips built into the base enclosure.

Disconnect the display panel cable (2) from the system board.

aua ~ WO N

Disconnect the microphone cable (3) from the system board.
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6. Disconnect the webcam cable (2) from the system board.

A CAUTION: Support the display assembly when removing the display screws in the following
steps. Failure to support the display assembly can result in damage to the assembly and other
components.

7. Remove the four black Phillips PM2.5x6.5 screws (1) that secure the display assembly to the
computer.

8. Remove the display assembly (2).
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9. Ifitis necessary fo replace any of the display assembly internal components, remove the following
screw covers and screws. The display screw covers are included in the display screw kit, spare
part number 592152-001.

(1) Two Mylar screw covers on the display bezel bottom edge

(2) Two Phillips PM2.5x4.0 screws
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10. Flex the inside edge of the top (1), the left and right sides (2), and the bottom (3) of the display
bezel until the bezel disengages from the display back cover.

11. Remove the display bezel (4). The display bezel is available using spare part number
592147-001 for HP computers, and 592148-001 for Presario computers.

Component replacement procedures 71



12. If it is necessary to replace the webcam module, disconnect the webcam cable (1) from the
module. Lift the webcam from the double-sided tape on the display back cover, and remove the
webcam.

13. If it is necessary to replace the display panel, remove the eight Phillips PM2.5x5.0 screws (1) that
secure the display panel to the display enclosure, and then lift the panel from the enclosure (2).
The display panel is available using the spare part number 592144-001.

14. If it is necessary to replace the display cable, follow these steps:
a. Turn the display panel upside down in front of you.
b. Peel back the tape that secures the cable to the display (1).
c.  Unplug the cable from the display (2).
d. Remove the cable from the display (3).
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15.

16.

17.

18.
19.

The display cable is available in the display cable kit, spare part number 592151-001.

If it is necessary fo replace the display bracket and hinges, remove the Phillips PM2.0x3.0 screws

(1) that secure each bracket to the display.

Remove the display hinges (2) from the display. The display bracket and hinge set is available
using spare part number 600627-001.
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If it is necessary to replace the wireless antennas and cables, remove the adhesive strip (1) that
secures each antenna to the display back cover.

Detach the wireless antenna (2) from the display back cover .

Remove the antenna cables from the clips (3) built into the display enclosure.
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20. Remove the wireless antennas and cables (4) from the display enclosure. The wireless antennas
and cables are included in the display cable kit, spare part number 592151-001.

21. If it is necessary to remove the webcam cable, remove the cable from the adhesive strips (1) along
the cable path on the display back cover, and then remove the webcam cable (2). The webcam
cable is included in the display cable kit, spare part number 592151-001,

to

74 Chapter 4 Removal and replacement procedures



22. If it is necessary to remove the microphone, release the microphone cable from the adhesive strips
(1) along the cable path on the display back cover, remove the microphone from the clips on the
display back cover (2), and then remove the microphone and microphone cable (3). The
microphone and cable is included in the display cable kit, spare part number 592151-001,

Reverse this procedure to reassemble and install the display assembly.
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System board

Description Spare part number
System board for use in models with discrete graphics subsystem 595181-001
System board for use in models with Unified Memory Architecture (UMA) graphics subsystem 595182-001
System board for use in models with discrete graphics subsystem and HDMI card reader 595183001
System board for use in models with UMA graphics subsystem and HDMI card reader 595184-001
System board for use in models with discrete graphics subsystem and Intel® HM55 chipset 608823-001

System board for use in models with discrete graphics subsystem, Intel® HM55 chipset, and HDMI  608824-001
card reader

System board for use in models with UMA graphics subsystem memory, Intel® GL40 chipset, and 605140001
HDMI card reader

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

RTC battery (see RTC battery on page 81)

Memory modules (see Memory module on page 50)

WLAN module (see WLAN module on page 47)

Modem module (see Modem module on page 61)

Before removing the system board, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. WILAN (see WLAN module on page 47)

c. Optical drive (see Optical drive on page 45)

d. Keyboard (see Keyboard on page 52)

e. Top cover (see Top cover on page 54)

f. Speaker assembly (see Speaker assembly on page 57)
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g. Display assembly (see Display assembly on page 69)

h. Top cover (see Top cover on page 54)

Remove the following cables from the system board if still connected:

®  Power connector cable (see Power connector cable on page 67)

®  Bluetooth cable (see Bluetooth module on page 63)

e USB board cable (see USB board on page 65)

1. Turn the computer upright with the right side toward you.

2. Remove the three Phillips PM2.5%3.0 screws that secure the system board to the computer.

3. Release the optical drive cable (1) from the system board.

4. lift the right side of the system board (2).
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5. Release the system board by sliding it to the right at an angle (3) until the connectors on the left
side of the system board clear the base enclosure, and then remove the system board.

7
e

6. Ifitis necessary to replace the modem module cable, remove the RJ-11 connector (1) from the clip
built into the base enclosure.

7. Remove the modem module cable (2) from the routing channel built into the base enclosure. The
modem module cable is available using spare part number 610791-001.

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

e  Fan/heat sink assembly (see Fan/heat sink assembly on page 83)

®  Processor (see Processor on page 86)

Reverse the preceding procedure to install the system board.
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Optical drive SATA cable and connector

Description Spare part number

Optical drive cable (included in the cable kit) 610791-001

Before removing the optical drive cable, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the following components:

b.

g.
h.

Hard drive (see Hard drive on page 42)

WILAN (see WLAN module on page 47)

Optical drive (see Optical drive on page 45)

Keyboard (see Keyboard on page 52)

Top cover (see Top cover on page 54)

Speaker assembly (see Speaker assembly on page 57)

Display assembly (see Display assembly on page 69)

System board (see System board on page 76)

Remove the optical drive cable

1.

Remove the two Phillips PM2.5x6.0 screws (1) that secure the optical drive connector to the
system board.
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2. Release the cable from the clips on the base enclosure (2), and then remove the cable (3).
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RTC battery

Description Spare part number

RTC battery 602745-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. WILAN (see WLAN module on page 47)

c. Optical drive (see Optical drive on page 45)

d. Keyboard (see Keyboard on page 52)

e. Top cover (see Top cover on page 54)

f. Speaker assembly (see Speaker assembly on page 57)

g. Display assembly (see Display assembly on page 69)

h. System board (see System board on page 76)

Remove the RTC battery:
1. Turn the system board upside down.

2. Release the RTC battery from the clips on the system board (1).
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3. Remove the RTC battery (2).

Reverse this procedure to install the RTC battery.
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Fan/heat sink assembly

Description

Spare part number

Fan/heat sink assembly for use in models that use Universal Memory Architecture (UMA) graphics ~ 595832-001
subsystem memory (includes thermal replacement material)

Fan/heat sink assembly for use in models that use and UMA graphics subsystem memory and the 606573001
Intel® GL40 chipset (includes thermal material)

Fan/heat sink assembly for use in models that use discrete graphics subsystem memory (includes 606573001

thermal material)

B NOTE: To properly ventilate the computer, allow at least a 7.6-em (3-inch) clearance on the right
side and rear panel of the computer. The computer uses an electric fan for ventilation. The fan is
controlled by a temperature sensor and is designed to turn on automatically when high temperature
conditions exist. These conditions are affected by high external temperatures, system power
consumption, power management/battery conservation configurations, battery fast charging, and
software requirements. Exhaust air is displaced through the ventilation grill located on the left side of

the computer.

Before removing the fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the

computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet

and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 52)

d. Top cover (see Top cover on page 54)

e. Speaker assembly (see Speaker assembly on page 57)

f. Display assembly (see Display assembly on page 69)

g. System board (see System board on page 76)

Remove the fan/heat assembly (fan/heat sink appearance may vary):
1. Turn the system board upside down.

2. Disconnect the fan cable (1) from the system board.
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3. Follow the sequence embossed on heat sink to loosen the four Phillips PM2.5x7.0 captive screws
(2) that secure the fan/heat sink assembly to the system board.

X NOTE: Due fo the adhesive quality of the thermal material located between the fan/heat sink
assembly and system board components, it may be necessary to move the fan/heat sink assembly
from side to side to detach the assembly.

4. Remove the fan/heat sink assembly (3).

The thermal material must be thoroughly cleaned from the surface of the fan/heat sink assembly (1),
(3) and the processor (2) and video components (4) each time the fan/heat sink assembly is removed.
Thermal pads and thermal paste must be installed on all surfaces before the fan/heat sink assembly is
reinstalled.

Ef NOTE: Thermal pads and thermal paste are included with all fan/heat sink assembly, system board,
and processor spare part kits.

The following illustration shows the locations for thermal material on systems with discrete graphics
subsystems.
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The thermal material must be thoroughly cleaned from the surface of the fan/heat sink assembly (1)
and (3), and the processor component (2), each time the fan/heat sink assembly is removed. Thermal
pads and thermal paste must be installed on all surfaces before the fan/heat sink assembly is
reinstalled.

The following illustration shows the locations for thermal material on systems with UMA graphics
subsystems.

Reverse this procedure to install the fan/heat sink assembly.
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Processor

Ef NOTE: All processor spare part kits include thermal material.

Description Spare part number
Intel Arrandale Core 620M 2.26-GHz 587259-001
Intel Arrandale 540M 2.53-GHz 594188001
Intel Arrandale 520M 2.4-GHz 594187001
Intel Arrandale i5-430M 2.26-GHz 597624-001
Intel Arrandale i3-350M 2.26-GHz 597623-001
Intel Arrandale i3-330M 2.13-GHz 597622-001
Intel Core 2 Duo Mobile processor T3000, 1.8-GHz 572926-001
Intel Core 2 Duo Mobile processor T4400 - 2.2-GHz 584296-001
Intel Core 2 Duo Mobile, 74300, 2.1-GHz 572929-001
Intel Core 2 Duo Mobile processor T3100 - 1.9-GHz 572925-001
Intel Core 2 Duo Mobile processor T3300 2.0-GHz 592399-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 52)

d. Top cover (see Top cover on page 54)

e. Speaker assembly (see Speaker assembly on page 57)

f. Display assembly (see Display assembly on page 69)

g. System board (see System board on page 76)

h. Fan/heat sink assembly (see Fan/heat sink assembly on page 83)
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Remove the processor:
1. Turn the processor locking screw (1) one-half turn counterclockwise until you hear a click.

2. lift the processor (2) straight up and remove it.

Ef NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon (4)
embossed on the processor socket when you install the processor.

Reverse this procedure to install the processor.
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5 Setup Utility

Computer Setup in Windows 7
To view the drives installed on the computer, select Start > Computer.

On models with a secondary hard drive (drive D), the optical drive becomes drive E. The next drive
added to the system, such as a new USB drive, will be assigned the next available drive letter.

Starting Setup Utility

Setup Utility is a ROM-based information and customization utility that can be used even when your
Windows® operating system is not working.

The utility reports information about the computer and provides settings for startup, security, and other
preferences.

To start Setup Utility:

A Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press f10.

—or —

1. Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press esc.

2. When the Startup Menu is displayed, press f10.
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Using Setup Utility

Changing the language of Setup Utility

The following procedure explains how to change the language of Setup Utility. If Setup Utility is not
already running, begin at step 1. If Setup Utility is already running, begin at step 2.

1. Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press f10.

—or —

Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press esc. When the
Startup Menu is displayed, press f10.

Use the arrow keys to select System Configuration > Language, and then press enter.
Use the arrow keys to select a language, and then press enter.

When a confirmation prompt with your language selected is displayed, press enter.

ol S

To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Your change goes into effect immediately.

Navigating and selecting in Setup Utility

Because Setup Utility is not Windows based, it does not support the TouchPad. Navigation and
selection are by keystroke.

e To choose a menu or a menu item, use the arrow keys.

® To choose an item in a list or to toggle a field, for example an Enable/Disable field, use either the
arrow keys or 5 or f6.

® To select an item, press enter.
® To close a text box or return to the menu display, press esc.

e To display additional navigation and selection information while Setup Utility is open, press f1.
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Displaying system information

The following procedure explains how to display system information in Setup Utility. If Setup Utility is
not open, begin at step 1. If Setup Utility is open, begin at step 2.

1. Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press f10.

- or —

Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press esc. When the
Startup Menu is displayed, press f10.

2. Select the Main menu. System information such as the system time and date, and identification
information about the computer is displayed.

3. To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press enter.

Restoring default settings in Setup Utility

The following procedure explains how to restore Setup Utility default settings. If Setup Utility is not
already running, begin at step 1. If Setup Utility is already running, begin at step 2.

1. Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press f10.

—or —

Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press esc. When the
Startup Menu is displayed, press f10.

2. Use the arrow keys to select Exit > Load Setup Defaults, and then press enter.
3.  When the Setup Confirmation is displayed, press enter.

4. To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Setup Utility default settings go into effect when the computer restarts.

B NOTE: Your password, security, and language settings are not changed when you restore the factory
default settings.
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Exiting Setup Utility
You can exit Setup Utility with or without saving changes.
e To exit Setup Utility and save your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Saving Changes, and then press enter.

e To exit Setup Utility without saving your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Discarding Changes, and then press enter.

After either choice, the computer restarts in Windows.

Setup Utility menus

The menu tables in this section provide an overview of Setup Utility options.

B NOTE: Some of the Setup Utility menu items listed in this chapter may not be supported by your
computer.

Main menu

Select To do this

System information e  View and change the system time and date.
e View identification information about the computer.

®  View specification information about the processor, memory size,

system BIOS, and keyboard controller version (select models only).

Security menu

Select To do this
Administrator password Enter, change, or delete an administrator password.
Power-On Password Enter, change, or delete a power-on password.
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System Configuration menu

Select

To do this

Language Support

Change the language of Setup Utility.

Button Sound (select models only)

Enable/disable the capacitive button tapping sound.

Virtualization Technology (select models only)

Enable/disable the processor Virtualization Technology.

Processor C6 State (select models only)

Enable/disable the processor C6 sleep state.

LAN Power Saving (select models only)

Enable/disable LAN Power Saving. When enabled, saves power when
the computer is in DC mode.

Card Reader/ 1394 Power Saving (select models
only)

Enable/disable Card Reader/1394 Power Saving.

Fan Always On

Enabled/disable Fan Always On. When enabled, the computer fan will
always be on.

Action Keys Mode

Enable/disable Action Keys Mode.

Boot Options

Set the following boot options:

e POST hotkey delay (sec.)—Set the delay for the {1, {2, {9, {10, 11,
and {12 functions of Setup Utility in intervals of 5 seconds each (O,
5,10, 15, 20).

e  CD-ROM Boot—Enable/disable boot from CD-ROM.
®  Floppy Boot—Enable/disable boot from diskette.

e Internal Network Adapter Boot—Enable/disable boot from the
internal network adapter.

e Boot Order—Set the boot order for:
> Notebook Hard Drive
° Internal CD/DVD ROM Drive
> USB Diskette on Key/USB Hard Disk
° USB CD/DVD ROM Drive
> USB Floppy

> Network Adapter

Diagnostics menu

Select

To do this

Hard Disk Self Test

Run a comprehensive selftest on the hard drive.

NOTE: On models with two hard drives, this menu option is called the
Primary Hard Disk Self Test.
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Select To do this

Secondary Hard Disk Self Test (select models only)  Run a comprehensive selftest on a secondary hard drive.

Memory Test Run a diagnostic test on the system memory.
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Computer Setup in Linux

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

B NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup, follow these steps:
1. Turn on or restart the computer.

2. Before your operating system opens and while the “F10=ROM Based Setup” message is displayed
in the lower-left corner of the screen, press f10.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing {10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not operating system based, it does not support the TouchPad.
Navigation and selection are by keystroke:

e To choose a menu or a menu item, use the arrow keys.
e To select an item, press enter.
e  To close open dialog boxes and return to the main Computer Setup screen, press esc.
e To view navigation information, press f1.
e To change the language, press 2.
2. Select the File, Security, Diagnostics, or System Configuration menu.
3. To exit Computer Setup, choose one of the following methods:

e To exit Computer Setup without saving your preferences, use the arrow keys to select File >
Ignore Changes And Exit. Then follow the instructions on the screen.

e To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.
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Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing {10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore Defaults, and then press enter.
3.  When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

B NOTE: Your password seftings and security settings are not changed when you restore the factory
seftings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

B NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your

computer.
File menu

Select To do this

System information e  View identification information for the computer.

e View specification information for the processor, cache
and memory size, and system ROM.

Restore Defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Password settings and security
settings are not changed when you restore the factory
seftings.)

Ignore Changes And Exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save Changes And Exit Save any changes entered during the current session. Then

exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

B NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Setup Password

Enter, change, or delete a setup password.

Power-On Password

Enter, change, or delete a power-on password.

Password Options

e Enable/disable stringent security.

e  Enable/disable the password requirement on computer
restart.

Drivelock Passwords

e  Enable/disable Drivelock on any computer hard drive.

e Enter, change, or disable Drivelock on an optional
MultiBay hard drive.

NOTE: Drivelock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

System IDs

Enter a user-defined computer asset tracking number and
ownership fag.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

e Fast: Runs the Disk Sanitizer erase cycle once.
e Optimum: Runs the Disk Sanitizer erase cycle 3 times.

e Custom: Allows you to select the desired number of Disk
Sanitizer erase cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the
primary hard drive is destroyed permanently.

Diagnostics menu

Select

To do this

HDD Self-Test Options

Run a comprehensive selfest on any hard drive in the system
or on any optional MultiBay hard drive.

Memory Check

Run a comprehensive check on system memory.
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System Configuration menu

B NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this
Language Change the Computer Setup language.
Boot options e Setanf9, {10, and {12 delay when starting up.

e  Enable/disable CD-ROM boot.
e  Enable/disable floppy boot.
e  Enable/disable internal network adapter boot.

e  Enable/disable MultiBoot, which sets a boot order that
can include most boot devices in the system.

e  Set the Express Boot Popup delay in seconds.
e Set the boot order.

> st boot device: USB CD-ROM

> 2nd boot device: USB floppy

> 3rd boot device: USB SuperDisk

> 4th boot device: Notebook hard drive

> 5th boot device: USB hard disk

o 6th boot device: Network controller

Device Configurations e Swap the functions of the fn key and left ctrl key.

e Enable/disable USB legacy support. When enabled,
USB legacy support allows the following:

> Use of a USB keyboard in Computer Setup even
when a your operating system is not running.

> Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

e  Enable/disable BIOS DMA data transfers.

®  Enable/disable fan always on while connected to an AC
outlet.

e  Enable/disable data execution prevention.
®  Enable/disable LAN power saving mode.
®  Enable/disable SATA Native Mode.

e  Enable/disable Dual Core CPU.

e  Enable/disable HDD translation mode.
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Select To do this

Built-in device options o  Enable/disable embedded WLAN Device Radio.
e  Enable/disable embedded Bluetooth Device Radio.
e  Enable/disable Network Interface Controller (NIC)
e Enable/disable LAN/WLAN Switching.
o  Enable/disable Wake on LAN.

e Enable/disable the integrated camera (webcam)

Port options e  Enable/disable USB port.

e Enable/disable ExpressCard slot.
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6 Specifications

Computer specifications

Dimensions
Depth 22.8 cm (8.98 in)
Width 34.2 cm (13.46 in)

Height (front to rear)

31.5 to 36.5 cm (1.24 to 1.44 in)

Weight (lowest weight configuration)

<2.20 kg (4.85 Ibs)

Input power

Operating voltage

18.5Vdc@4.74 A-90 W

Operating current

474 A

Temperature

Operating (not writing fo optical disc)

0°C to 35°C (32°F to 95°F)

Operating (writing to optical disc)

5°C to 35°C (41°F to 95°F)

Nonoperating

-20°C to 60°C (-4°F to 140°F)

Relative humidity

Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m (-50 ft to 10,000 f)

Nonoperating -15 m to 12,192 m (-50 ft to 40,000 f)

NOTE: Applicable product safety standards specify thermal limits for
plastic surfaces. The computer operates well within this range of
temperatures.
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35.6-cm (14.0-in) display specifications

Dimensions

Height 17.6 em (17.6 cm)
Width 31.1 em (12.24 in)
Diagonal 35.7 cm (14.06 in)
Number of colors Up to 16.8 million
Contrast ratio 300:1 (typical)
Brightness 200 nits (typical)

Pixel resolution

Pitch 0.259 x 0.259 mm

Format 1280 x 800; HD: 1366 x 768
Configuration RGB vertical stripe

Backlight LED

Character display 80 x 25

Total power consumption 4.0W

Viewing angle +40° horizontal, +120/-40° vertical (typical)
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Hard drive specifications

500-GB* 320-GB* 250-GB* 160-GB*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm
Width 70 mm 70 mm 70 mm 70 mm
Weight 101 g 101 g 101 g 101 g
Interface type SATA SATA SATA SATA
Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec
Security ATA security ATA security ATA security ATA security
Seek times (typical read, including setting)
Single track 1.0 ms 1.5 ms 2.0 ms 1.5 ms
Average 14.0 ms 12.0 ms 12.0 ms 11.0 ms
Maximum 22.0 ms 22.0 ms 22.0 ms 22.0 ms
Logical blocks 976,773,168 625,142,448 488,397,168 312,581,808
Disc rotational speed 7200 rpm 7200 rpm 7200 rpm 7200 rpm

Operating temperature

5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive

specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD+RW SuperMulti Double-Layer Drive with
LightScribe specifications

Applicable disc

Read CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-ROM XA, MIXED
MODE CD, CD-, CDl Bridge (Photo-CD, Video CD), Multisession CD (Photo-
CD, CD-EXTRA, Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R, DVD+RW, DVD-RAM
Write CDR and CDRW, DVD+R, DVD+RW, DVDR, DVD-RW, DVD-RAM

Random access time

DVD <230 ms
CD <175 ms
Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
24X CDR 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec

Transfer mode

Multiword DMA Mode
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Blu-ray ROM with LightScribe DVD+R/RW
SuperMulti DL Drive specifications

Applicable disc

Read

BD-ROM, BD-ROM-DL, BD-R, BD-R-DL, BD-RE, BD-RE-DL, DVD-ROM, DVD+R,
DVD+R-DL, DVD+RW, DVD-R, DVDR-DL, DVD-RW, DVD-RAM (Ver.2), CD-
DA, CD-ROM (mode 1 and mode 2), CD-ROM XA (mode 2, form 1 and
form 2), Photo CD (single and multiple sessions), CD Extra, CDR, CD-RW,
and CD-TEXT

Write

DVD-RAM (Ver.2), DVD+R, DVDR, CDR, and CD-ROM

Random access time

BD <230 ms
DVD <180 ms
CD < 180 ms
Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
4X BD 18,000 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVDR 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD4R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec
1X BD-ROM 4,500 KB/sec
1X BDR read 4,500 KB/sec

1X BD-RE read

4,500 KB/sec

Transfer mode

Multiword DMA Mode
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System resource specifications

You can use Device Manager to get a graphical view of the system resources that control how the
devices work on the computer. System resources you can access from Device Manager are direct
memory access (DMA) channels, input/output (I/O) ports, interrupt request (IRQ) lines, and memory
addresses.

If two devices require the same resource and create a device conflict, you can manually change the
resource settings in Device Manager to be sure each setting is unique.

A CAUTION: Improperly changing resource settings can disable your hardware and cause your
computer to malfunction or become inoperable. Only users who have expert knowledge of computer
hardware and hardware configurations should change resource settings.

To view resource settings in Windows 7 and Windows Vista:
1. Select Start > Computer.
2. Click System properties near the top of the Computer folder.
3. On the left, click Device Manager.
4. On the View meny, click one of the following:
e Resources by type
e Resources by connection
To view resource settings in Windows XP:
1. Select Start > My Computer, or doubleclick My Computer on the desktop.
Under System Tasks, click View system information.
In the System Properties window, select the Hardware tab.

Click Device Manager.

L R

On the View menu, click one of the following:
e Resources by type

¢ Resources by connection
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7 Backup and recovery

Recovery after a system failure is as complete as your most current backup. HP recommends that you
create recovery discs immediately after software setup. As you add new software and data files, you
should continue to back up your system on a regular basis to maintain a reasonably current backup.

Tools provided by the operating system and HP Recovery Manager software are designed to help you
with the following tasks for safeguarding your information and restoring it in case of a system failure:

e  Creating a set of recovery discs (Recovery Manager software feature). Recovery discs are used to
start up (boot) your computer and restore the operating system and software programs to factory
settings in case of system failure or instability.

®  Backing up your information regularly to protect your important system files.

e  Creating system restore points (operating system feature). System restore points allow you to
reverse undesirable changes to your computer by restoring the computer to an earlier state.

®  Recovering a program or driver (Recovery Manager software feature). This feature helps you
reinstall a program or driver without performing a full system recovery.

e  Performing a full system recovery (Recovery Manager software feature). With Recovery Manager,
you can recover your full factory image if you experience system failure or instability. Recovery
Manager works from a dedicated recovery partition (select models only) on the hard drive or from
recovery discs you create.

Ef NOTE: Computers with a solid-state drive (SSD) may not have a recovery partition. Recovery
discs have been included for computers that do not have a partition. Use these discs to recover
your operating system and software. To check for the presence of a recovery partition, select
Start, rightclick Computer, click Manage, and then click Disk Management. If the partition
is present, an HP Recovery drive is listed in the window.

Windows 7

To protect your information, back up your files and folders. In case of system failure, you can use the
backup files to restore your computer.

A CAUTION: In the event of a hard drive failure, you cannot use your computer to access the Disaster
Recovery utility. Therefore, HP recommends that you download the Disaster Recovery utility SoftPaq,
and then extract it to a USB flash drive as soon as possible after software setup. For details, refer to
“Downloading and exiracting the Disaster Recovery utility” later in this section.
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Depending on your computer model, you may have one of the following backup and recovery
solutions:

e  Roxio BackOnTrack

e HP Recovery Manager

B NOTE: For detailed information, perform a search for these topics in Help and Support.

Creating recovery discs

HP recommends that you create recovery discs to be sure that you can restore your system to its original
factory state if you experience serious system failure or instability. Create these discs after setting up the
computer for the first time.

Handle these discs carefully and keep them in a safe place. The software allows the creation of only
one set of recovery discs.

Ef NOTE: You can use an optional external optical drive (purchased separately) to create recovery
discs, or you can purchase recovery discs for your computer from the HP Web site.

Note the following guidelines before creating recovery discs:

B NOTE: The external hard drive must be connected to a USB port on the computer, not to a USB port
on an external device such as a hub.

®  You will need high-quality DVD-R, DVD+R, BD-R (writable Blu-ray), or CDR discs. All these discs
are purchased separately. DVDs and BDs have a much higher capacity than CDs. If you use CDs,
up to 20 discs may be required, whereas only a few DVDs or BDs are required.

B NOTE: Read-write discs, such as CD-RW, DVD+RW, double-layer DVD+RW, and BD-RE
(rewritable Blu-ray) discs, are not compatible with the Recovery Manager software.

®  The computer must be connected to AC power during this process.
®  Only one set of recovery discs can be created per computer.
®  Number each disc before inserting it into the optical drive.

e If necessary, you can exit the program before you have finished creating the recovery discs. The
next time you open Recovery Manager, you will be prompted to continue the disc creation
process.

To create a set of recovery discs:
1. Select Start > All Programs > Recovery Manager > Recovery Disk Creation.

2. Follow the on-screen instructions.
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Backing up your information

As you add new software and data files, you should back up your system on a regular basis to
maintain a reasonably current backup. Back up your system at the following times:

®  Atregularly scheduled times

B NOTE: Set reminders to back up your information periodically.

e  Before the computer is repaired or restored
e  Before you add or modify hardware or software
Note the following when backing up:

e  Create system restore points using the Windows® System Restore feature, and periodically copy
them to disc.

e  Store personal files in the Documents library and back up this folder periodically.
e  Back up templates stored in their associated programs.

e  Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have fo reset your preferences.

To copy the screen and paste it info a word-processing document, follow these steps:
1. Display the screen.
2. Copy the screen:
To copy only the active window, press alt+prt sc.
To copy the entire screen, press prt sc.
3. Open a word-processing document, and then select Edit > Paste.
4. Save the document.
®  You can back up your information to an optional external hard drive, a network drive, or discs.

®  When backing up to discs, use any of the following types of discs (purchased separately): CDR,
CD-RW, DVD+R, DVD-R, or DVD+RW. The discs you use will depend on the type of optical drive
installed in your computer.

B NOTE: DVDs store more information than CDs, so using them for backup reduces the number of
recovery discs required.

®  When backing up to discs, number each disc before inserting it into the optical drive of the
computer.
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Using Windows Backup and Restore

To create a backup using Windows Backup and Restore, follow these steps:

Ef NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up and create a backup.

Ef NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing software,
running utilities, or changing Windows settings. Refer to Help and Support for more information.
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Using system restore points

When you back up your system, you are creating a system restore point. A system restore point allows
you to save and name a snapshot of your hard drive at a specific point in time. You can then recover
back to that point if you want to reverse subsequent changes made to your system.

B NOTE: Recovering to an earlier restore point does not affect data files saved or e-mails created since
the last restore point.

You also can create additional restore points to provide increased protection for your system files and
settings.

When to create restore points

Before you add or extensively modify software or hardware

Periodically, whenever the system is performing optimally

B NOTE: If you revert to a restore point and then change your mind, you can reverse the restoration.

Create a system restore point

1.

S o

Select Start > Control Panel > System and Security > System.

In the left pane, click System Protection.

Click the System Protection tab.

Under Protection Settings, select the disk for which you want to create a restore point.
Click Create.

Follow the on-screen instructions.

Restore to a previous date and time

To revert o a restore point (created at a previous date and time), when the computer was functioning
optimally, follow these steps:

1.

2
3.
4
5

Select Start > Control Panel > System and Security > System.
In the left pane, click System protection.

Click the System Protection tab.

Click System Restore.

Follow the on-screen instructions.

Performing a recovery

B NOTE: You can recover only files that you have previously backed up. HP recommends that you use

HP Recovery Manager to create a set of recovery discs (entire drive backup) as soon as you set up your
computer.
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Recovery Manager software allows you to repair or restore the system if you experience system failure
or instability. Recovery Manager works from recovery discs or from a dedicated recovery partition
(select models only) on the hard drive. However, if your computer includes a solid-state drive (SSD), you
may not have a recovery partition. If that is the case, recovery discs have been included with your
computer. Use these discs to recover your operating system and software.

% NOTE: Windows has its own built-in repair features, such as System Restore. If you have not already
tried these features, try them before using Recovery Manager.

NOTE: Recovery Manager recovers only software that was preinstalled at the factory. Software not
provided with this computer must be downloaded from the manufacturer's Web site or reinstalled from
the disc provided by the manufacturer.

Recovering from the recovery discs
To restore the system from the recovery discs:
1. Back up all personal files.
2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Recovering from the dedicated recovery partition (select models only)

B NOTE: Computers with an SSD may not have a recovery partition. If the computer does not have a
recovery partition, you will not be able to recover using this procedure. Recovery discs have been
included for computers that do not have a partition. Use these discs to recover your operating system
and software.

On some models, you can perform a recovery from the partition on the hard drive, accessed by
pressing either the Start button or f11. This restores the computer to its factory condition.

To restore the system from the partition, follow these steps:
1. Access Recovery Manager in either of the following ways:
e  Select Start > All Programs > Recovery Manager > Recovery Manager.
—or-

e  Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen. Then, press {11 while the “Press
<F11> for recovery” message is displayed on the screen.

2. Click System Recovery in the Recovery Manager window.

3. Follow the on-screen instructions.
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Linux backup and recovery

Use the instructions in this section if SUSE Linux SLED 11 is installed on your computer.

To protect your information, back up your files and folders. Then if the system fails, you can restore
your important files from copies. You can also use the options listed in this section to restore the
operating system and programs that were installed at the factory.

A CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The {11
recovery tool reinstalls the original operating system and HP programs and drivers that were installed at
the factory. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal
files must be restored from a backup.

To recover the original hard drive image using f11, follow these steps:
1. If possible, back up all personal files.

2. Restart the computer, and then press {11 while the “Press <F11> for recovery” message is
displayed on the screen.

3. Follow the on-screen instructions.

NOTE: If you are unable to boot (start up) your computer from the primary operating system or from

the recovery f11 method, you must purchase a SUSE Linux Enterprise Desktop Operating System DVD

to repair the operating system. For additional information, refer to the Worldwide Telephone Numbers
booklet, included with the computer.
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8 Connector pin assignments

Audio-out (headphone)

Signal

Audio out, left channel

Audio out, right channel

Ground

Audio-in (microphone)

1
Pin Signal
1 Audio signal in
2 Audio signal in
3 Ground
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External monitor

@ OO0 6
®000
®00006

Pin Signal

1 Red analog

2 Green analog
3 Blue analog

4 Not connected
5 Ground

6 Ground analog
7 Ground analog
8 Ground analog
9 +5 VDC

10 Ground

11 Monitor detect
12 DDC 2B data
13 Horizontal sync
14 Vertical sync
15 DDC 2B clock

114 Chapter 8 Connector pin assignments



RJ-11 (modem)

Signal

Pin

Tip

RJ-45 (network)

Signal

Pin

Transmit +

smit -
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HDMI

1917151311 9 7 5 3 1

Coooooooo

1816 1412 10 8 & 4 2

Pin Signal

1 TMDS data 2+

2 TMDS data 2 shield
3 TMDS data 2-

4 TMDS data 1+

5 TMDS data 1shield
6 TMDS data 1-

7 TMDS data O+

8 TMDS data O shield
9 TMDS data O-

10 TMDS clock+

11 TMDS clock shield
12 TMDS clock—

13 CEC

14 No connect

15 DDC clock

16 DDC data

17 Ground

18 +5V power

19 Hot plug detect

20 Shell
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Universal Serial Bus

1 2 3 4
I_-_-_-.I

Pin Signal
1 +5 VDC
2 Data -
3 Data +
4 Ground
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9 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries or regions must meet the requirements of the country or region
where the computer is used.

Requirements for all countries or regions

The requirements listed below are applicable to all countries or regions:

The length of the power cord set must be at least 1.5 m (5.0 f) and no more than 2.0 m (6.5 ft).

All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by each country or region’s power system.

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries or regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
ltaly IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CCcC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

A CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

B NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eice.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

g -

B NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

—0

u
o\

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside-down.

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

24. Recycle the LCD panel and backlight.
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1394 Power Saving 92

A
AC adapter
identifying 17
AC adapter, spare part
numbers 28
administrator password 91
antenna
removal 73
antennas 16
applications key, Windows 11
audio, product description 4
audio-in jack, pin
assignments 113
audio-out jack, pin
assignments 113

B
backing up
customized window, toolbar,
and menu bar seftings 108
personal files 108
templates 108
base enclosure, spare part
number 23
battery
removal 41
spare part numbers 23, 41
battery bay, identifying 15
battery release latch,
identitying 15
battery, identifying 17
bays
battery 15
hard drive 15
BD/DVD+R/RW Super Multi
Double-Layer Combo Drive
removal 45
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bezel
illustrated 19
spare part number 24, 71
Blu-ray Disc ROM LightScribe with
SuperMulti DVD+R/RW Double-
Layer
spare part number 23, 27, 45
Blu-ray ROM with LightScribe DVD
+R/RW SuperMulti DL Drive
specifications 104
Bluetooth module
removal 63
spare part number 23, 63
boot options 92, 98
boot order 92, 98
button sound 92
buttons
power 10
TouchPad right/left 8

C
cable kit, spare part number 23
cables, service considerations 35
camera module

removal 72

spare part number 72
camera, product description 4
caps lock light, identifying 9
Card Reader Power Saving 92
changing the language of Setup

Utility 89

chipset, product description 1
compartments

memory module 15
components

additional hardware 17

bottom 15

front 7

leftside 14

rightside 13

top 8
computer feet

locations 40

spare part number 40
Computer Setup

accessing 94

Diagnostics menu 97

File menu 96

navigating and selecting 94

restoring factory settings 95

Security menu 97

System Configuration menu 98

using 94
computer specifications 100
connector pin assignments

audio-in 113

audio-out 113

external monitor 114

HDMI 116

headphone 113

microphone 113

modem 115

monitor 114

network 115

RI-T1T 115

R-45 115

Universal Serial Bus (USB) 117
connector, power 13
connectors, service

considerations 35

cord, power 17

D
Diagnostics menu 92, 97
Digital Media Slot light,
identifying 14
Digital Media Slot, identifying 14



diskette drive
precautions 35
product description 4
display assembly
removal 69
spare part number
display back cover
spare part number 25
display bezel
illustrated 19
spare part number 24, 71
display bracket and hinge
removal 73
spare part number 73
display cable kit
spare part number 24
display component recycling 120
display components
illustrated 19
spare part numbers 19
display enclosure
illustrated 19
display hinge kit, spare part
number 24
display inverter
illustrated 19
display panel
illustrated 19
product description 3
removal 72
spare part number 24, 72
Display screw kit, spare part
number 25
display specifications 101
displaying system information 90
drives
boot order 92, 98
preventing damage 35
DVD/CD-RW Combo Drive
precautions 35
removal 45
DVD+RW and CD-RW Combo
Drive
precautions 35
removal 45
DVD+RW SuperMulti DL Drive with
LightScribe
spare part
numbers

19, 69

23,27, 45

DVD+RW SuperMulti Double-Layer
Drive with LightScribe
specifications 103

E
electrostatic discharge 36
esc key, identifying 11
Ethernet, product description 4
exiting Setup Utility 91
external media cards, product

description 5
external monitor port

pin assignments 114

external monitor port,

identifying 14

F
fir 1
fan always on 92
fan/heat sink assembly
removal 78
spare part number 20, 78
feet
locations 40
spare part number 40
File menu 96
fn key, identifying 11
front components 7
full system recovery 106
function keys, identifying 11

G
graphics, product description 2

grounding equipment and
methods 38

H
hard drive
precautions 35
product description 3
removal 42
spare part
numbers 23, 27, 42
specifications 102
hard drive bay, identifying 15
hard drive cover
illustrated 26
removal 43
hard drive hardware kit, spare part
number 27
hard drive self test 92

HDMI 14
HDMI port, pin assignments 116
headphone jack, pin

assignments 113

|
inverter
illustrated 19

J

jacks
RJ-11 (modem) 13
RJ-45 (network 14

K

keyboard
product description 5
removal 52

spare part numbers 20, 52
keys
esc 11

fn 11

function 11

navigation 11

Windows applications 11
Windows logo 11

L
LAN Power Saving 92
language support 92
latch, battery release 15
legacy support, USB 94, 98
light
power 9
lights
caps lock 9
Digital Media Slot 14
optical drive 13
webcam 12
wireless 9

M
Main menu 91
mass storage devices, spare part
numbers 23
memory module
product description 3
removal 50
spare part numbers 21, 50
memory module compartment,

identifying 15
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memory test 93
microphone (internal),
identifying 12
microphone jack, pin
assignments 113
microphone, product
description 4
mini-card compartment cover
illustrated 26
removal 51
spare part number 51
model name 1
modem cable
noise suppression circuitry 17
modem jack, pin
assignments 115
modem module
product description 4
removal 61
spare part number 21, 61
modem module cable
removal 78
monitor port, external 14
monitor port, pin
assignments 114

N
navigating in Setup Utility 89
navigation keys, identifying 11
network jack, pin
assignments 115
noise suppression circuitry
modem cable 17

o
ODD cable
removal 79
spare part number 79
operating system, product
description 6
optical drive
identifying 13
precautions 35
product description 3
removal 45
spare part
numbers 23, 27, 45
specifications 103, 104
optical drive light, identifying 13
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P
packing guidelines 37
passwords 91, 97

performing a recovery 110
plastic parts 34
Plastics kit

contents 26

spare part number 26
plastics kit

spare part number 21
pointing device, product

description 5

ports
external monitor 14
HDMI 14
product description 5
USB 13, 14

power button board

removal 58

spare part number 58
power button, identifying 10
power connector cable

removal 67

spare part number 23, 67
power connector, identifying 13
power cord set requirements 118
power cord, identifying 17
power cord, spare part

numbers 28
power light, identitying 9
power requirements, product
description 6

power-on password 91
processor

product description 1

removal 78

spare part numbers
Processor C6 State 92
product description

22,78

audio 4
camera 4
chipset 1

diskette drive 4
display panel 3
Ethernet 4

external media cards 5
graphics 2

hard drives 3
keyboard 5

memory module 3

microphone 4
modem module 4
operating system 6
optical drives 3
pointing devices 5
ports 5
power requirements 6
processors 1
product name 1
security 6
serviceability 6
wireless 4
product name 1

R
recovering a program or
driver 106
recovering from the dedicated
recovery partition 111
recovering from the recovery
discs 111
recovery discs 106, 107
Recovery Manager 106, 111
recovery partition 106
recovery, system 111
removal/replacement
preliminaries 34
procedures 39
restore points 110
restoring default settings 90
RJ-11 (modem) jack,
identifying 13
RJ-11 jack, pin assignments 115
RJ-45 (network) jack,
identifying 14
RJ-45 jack, pin assignments 115
RTC battery
removal 76
spare part number 21, 76
Rubber Feet Kit, spare part
number 40

S

secondary hard drive self test 93
security cable slot, identifying 13
Security menu 91, 97

security, product description 6
selecting in Setup Utility 89
serial number 18, 39

service considerations 34



serviceability, product
description 6

setup utility

Diagnostics menu 97

File menu 96

navigating and selecting 94

restoring factory seftings 95

Security menu 97

System Configuration menu 98
slots

Digital Media 14

memory module 15

security cable 13
solid-state drive (SSD)
speaker assembly

removal 57

spare part number 20, 57
speakers, identifying 10
specifications

Blu-ray ROM with LightScribe

DVD+R/RW SuperMulti DL

106, 111

Drive 104
computer 100
display 101

DVD +RW SuperMulti Double-
Layer Drive with

LightScribe 103
hard drive 102
optical drive 103, 104

system resources 105
starting Setup Utility 88
static-shielding materials 38
stringent security 97
supported discs 107
system board

removal 76

spare part numbers
System Configuration

20,76

menu 92, 98
system failure or instability 106
system fan 98
system information 91, 96
system recovery 111
system resources 105
system restore points 106, 110

T

thermal paste,
replacement 84, 85

tools required 34

top cover

removal 54

spare part number 20, 54
TouchPad

buttons 8

identitying 8

removal 59
TouchPad button board

spare part number 59
TouchPad zone

identitying 8
transporting guidelines 37

U
Universal Serial Bus (USB) port, pin
assignments 117
USB board
removal 65
spare part number 22, 65
USB legacy support 94, 98
USB ports, identifying 13, 14
using Setup Utility 89
using system restore 110

v
vents, identifying 14, 15
Virtualization Technology 92

w
webcam
identifying 12
webcam light, identifying 12
Webcam module
spare part number 25
Windows applications key,
identifying 11
Windows logo key,
identitying 11
wireless antenna
removal 73
wireless antennas 16
wireless antennas and cables
removal 74
spare part number 74
wireless antennas and cables,
spare part number 74
wireless light 9
wireless, product description 4

wireless/memory module

compartment cover
removal 48

spare part number 48

WILAN module

removal 47

spare part numbers 21, 47

workstation guidelines
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